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Introduction

Features 

The EPSON scanner software suite, EPSON Scan! II and
EPSON TWAIN, is the perfect companion for your EPSON
scanner. Using your scanner and scanning software, you can
scan images in color, grayscale, or black-and-white and save
the scanned images to disk as files. 

❑ The software supports the following EPSON scanners:
EPSON GT-9500, GT-8500, GT-5500, GT-5000, ES-1000C,
Action Scanner II, and Expression 636.

❑ EPSON TWAIN directly controls all of the features of your
EPSON scanner. This program is the core of EPSON Scan!
II and the standard cross-platform interface for other
application programs.

❑ EPSON Scan! II allows you to access all of the advanced
features of EPSON TWAIN, to scan images, to save
scanned images, and to export them into other applications.

❑ You can also convert the files to various formats, such as
JPEG and TIFF, for use with your favorite desktop
publishing or image processing software.

❑ EPSON calibration utilities allow you to calibrate your
scanner and output devices (printers and display monitors)
to reproduce images identical to the originals.

Proof Sign-off:
E. Ohtera _______
D. Grady _______
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About This Guide 

The information in this guide is divided into six chapters, also a
glossary and index are provided for your reference. 

❑ Chapter 1 contains information on installing the software.
Be sure to read this chapter first.

❑ Chapter 2 shows you the basics of scanning.

❑ Chapters 3 and 4 provide you with a complete description
of EPSON Scan! II and EPSON TWAIN features. Refer to
Chapter 4 when making settings while scanning.

❑ Chapter 5 explains how to calibrate your monitor and
printer with your EPSON scanner. If you notice that colors
on your screen or in your printout do not match the
original image, see this chapter.

❑ Chapter 6 contains troubleshooting information. If this
software does not operate properly or scanned images are
not what you expect, see this chapter.

Notes contain important information and useful tips on operating
your scanner or software.

To set up and use the scanner itself, see your scanner’s User’s
Guide. Online help can also provide you with information
about settings in EPSON TWAIN.
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Chapter 1
Installing the Software

Proof Sign-off:
E. Ohtera _______
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System Requirements 

Before installing the scanner software, make sure that your
system meets the following requirements.

Compatible
scanners: EPSON GT-9500, GT-8500, GT-5500, GT-5000,

ES-1000C, Action Scanner II, and Expression 636

For Windows Users

System: Microsoft® Windows® 95, Windows 3.1x, 
Windows for Workgroups 3.1x, Windows NT®

3.5x, or Windows NT 4.0

Interface: EPSON bidirectional parallel interface or
Adaptec® SCSI adapter

Note:
❑ The interface may vary depending on the scanner

model, see your scanner manual for connection
instructions.

❑ If you are using Windows NT, you cannot use a
bidirectional parallel interface; you need to use
the Adaptec SCSI adapter.

❑ If you use an Adaptec SCSI adapter with
Windows 3.1x or Windows for Workgroups,
make sure EZ-SCSI (from Adaptec) is installed.
EZ-SCSI does not need to be installed if you are
running Windows 95 or Windows NT.

❑ You cannot use a serial interface with this
software.
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Display: VGA or higher resolution monitor 640 × 480
screen resolution (800 × 600 or higher
recommended), and 256-color (65,000-color or
higher recommended)

Note:
Color and tone reproduction are subject to the display
capability of your computer system, including the
video card, display monitor, and software. See the
manuals for those products for details.

For Macintosh Users

System: Apple® Macintosh® computer (except the Plus,
SE, Classic, and Power Book 100) running
system 7.x, 7.5.x, or 7.6.x

Interface: Macintosh standard (SCSI)

Note: 
You cannot use a serial interface.

Display: Color Monitor, 640 x 480 screen resolution (or
higher recommended), and 256-color
(32,000-color or higher recommended)

Note:
Color and tone reproduction are subject to the display
capability of your computer system, including the
video card, display monitor, and software. See the
manuals for those products for details.

EPSON Scan! II supports the Apple ColorSync 2.0 color
management system and QuickTime. The ColorSync and
QuickTime extensions are automatically installed during
EPSON Scan! II installation.
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Installing the Scanner Software for Windows 

After connecting the scanner to your computer, install the scanner
software (EPSON Scan! II & EPSON TWAIN) from the FD or
CD-ROM. The installation steps differ depending on the version
of Windows you use. Instructions for Windows 95 and NT 4.0
users are in the next section, and instructions for Windows 3.1x,
Windows for Workgroups, and NT 3.5x users begin in “For
Windows 3.1x and Windows NT 3.5x users” on page 1-9.

Note:
If you are using the floppy disk version of the software, make a backup
copy of the scanner software before you begin installation.

For Windows 95 and Windows NT 4.0 users

1. Make sure that the scanner is turned on.

2. Turn on the computer, and start Windows. 

If you use the parallel interface model of the EPSON Scanner 
or if you are using Windows NT 4.0, insert the scanner
software CD in the CD-ROM drive. (If you are using the
floppy disk version, insert it in the FD drive.) Go to step 3.

If you use Windows 95 with the SCSI interface model of the
EPSON Scanner, either of the following dialog boxes may
appear.
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❑ If the following dialog box appears, insert the scanner
software CD (or FD) in the CD-ROM (or FD) drive. 

Select Driver from disk provided by hardware
manufacturer, then click OK. Click Browse. Select the
CD-ROM (or FD) drive, then click OK. Go to step 3.

❑ If the following dialog box appears, insert the scanner
software CD (or FD) in the CD-ROM (or FD) drive, then
click Next.

device2

osr2a
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If the following dialog box appears, click Finish.

3. Double-click the My Computer icon.

4. Double-click the CD-ROM drive icon. You see the EPSON
folder. (For the floppy disk version, double-click the FD drive
icon.) 

Note:
If the folder contains a README file, double-click it and read it.
This file contains important information and any updates
regarding this software.

5. Double-click the SETUP.EXE icon. Follow the instructions on
the screen.

The setup program first installs EPSON Scan! II, and then it
installs EPSON TWAIN.

osr2b
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6. After EPSON Scan! II and EPSON TWAIN are installed, the
EPSON TWAIN Setup dialog box appears.

7. For the parallel interface model
Make sure that BiD Parallel is selected in the Interface
pop-up list.
Make sure that the port address setting matches the port
address of the interface board as shown below. (Use the
port address you wrote down when you installed the
parallel interface board.)

Interface board Port Id setting in the EPSON TWAIN
Setup dialog box

LPT1 Port 378

LPT2 Port 278

Note:
You do not need to change the port address setting if you
install the parallel interface board packed with your scanner
without changing jumper settings.

For information on I/O port addresses, see the user’s guide
that came with the parallel interface board.

port2
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For the SCSI interface model
Make sure that SCSI is selected in the Interface pop-up list.
Make sure your EPSON scanner appears in the Port ID list.
If it does not appear, see Chapter 6, “Troubleshooting.”

8. Place a document on the document table of the scanner.

9. Click Test to check the connection. The scanner scans the
document and a scanned reproduction appears in the right
window of the dialog box if everything is properly installed
and connected.

If no image appears, see Chapter 6, “Troubleshooting.”

10. Click OK to close the EPSON TWAIN Setup dialog box.

The EPSON Screen Calibration utility automatically starts. Go
to page 1-11.

Note: 
It may take some time after clicking OK to start the EPSON Screen
Calibration utility depending on the Windows version. 

test2
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For Windows 3.1x and Windows NT 3.5x users

1. Make sure that the scanner is turned on.

2. Turn on the computer and start Windows.

3. Insert the scanner software CD in the CD-ROM drive. (If you
are using the floppy disk version, insert it in the FD drive.)

4. Choose Run from the File menu. 

5. Click Browse. Then select the CD-ROM (or FD) drive. 

6. Choose SETUP.EXE, then click OK. Follow the instructions 
on the screen.

7. When the following dialog box appears, follow the steps on
page 1-7 from step 6.

port2
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Installing the Scanner Software for Macintosh 

After connecting the scanner to your Macintosh computer,
install the scanner software (EPSON Scan! II & EPSON
TWAIN) from the FD or CD-ROM. Follow the steps below.

1. Make sure your scanner is on. Then turn on the computer.

2. Insert the CD in the CD-ROM drive. If you are using the
floppy disk version, insert it in the FD drive.

3. Double-click the disk icon to open it.

4. Double-click the EPSON Scan! II Installer icon.

5. The installer software shows a dialog box. Click Install in the
dialog box that appears, and follow the instructions on the
screen.

When you have finished the entire installation, the EPSON
Screen Calibration utility automatically starts. Go to the next page.

L EPSON Scan! II Rev.C
A5 size Chapter 1
July-18-97 Pass 0, DR

1-10      Installing the Software



Calibrating Your Screen 

After the scanning software has been installed, the following
dialog box appears.

You must calibrate your screen and scanner to reproduce
images identical to the originals. Follow the steps below.

1. Click Next.

2. In the following window, move the slider to the right or left
until the shades of gray of the two sets of horizontal stripes
match.

setup2

calib
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Note:
View the screen from a slight distance. The gray stripes will not
perfectly blend together; the object is to make the different tones
match as much as possible.

3. Click OK to register the calibration setting.

4. The message, “Setup is complete” appears. Click OK.

You will not need to change the screen calibration again so long
as you continue to use the same display.
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Scanning Basics
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Starting the Software 

After installing the scanner software, the EPSON Scan! II icon
appears in your Windows’ EPSON Scanner group (folder), or
the EPSON Scan! II folder appears in your Macintosh HDD. If
it does not appear, install the software as described on page 1-4
(Windows) or 1-10 (Macintosh).

There are two ways to scan, with EPSON Scan! II or with an
application that supports TWAIN.

If you .. 

❑ want to use the EPSON Scan! II features to improve the
scanned output,

r Open EPSON Scan! II (see “Starting EPSON 
TWAIN through EPSON Scan! II” on page 2-3)

❑ do not have scanning software or your software does not
support EPSON TWAIN,

r Open EPSON Scan! II (see “Starting EPSON 
TWAIN through EPSON Scan! II” on page 2-3)

❑ use an application that supports EPSON TWAIN to scan,
r Open your application (see “Starting EPSON 

TWAIN through your application software” on 
page 2-5)

Note:
Even if your application supports TWAIN, some features 
of EPSON TWAIN may not be available depending on the 
application software.
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Starting EPSON TWAIN through EPSON Scan! II

Before you start EPSON Scan! II, turn on the scanner and place
a document on the document table of your scanner. For
instructions about placing a document, see your scanner
manual.

Note:
If you start EPSON Scan! II before turning on your scanner, you
may not be able to scan properly.

1. For Windows 95 and NT 4.0 users: 
Click Start, Program, EPSON Scanner, then choose
EPSON Scan! II32, which is the 32-bit version of the
scanning software. 

For Windows 3.1x, NT 3.5x, and Macintosh users: 
Open the EPSON Scanner group (folder). Then double-click
the EPSON Scan! II icon.

Choose
open

double-click

For Windows 3.1x and NT 3.5x

icon
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2. Choose Select Source from the File menu. Make sure that
EPSON TWAIN is selected in the Data Source list box, then
click Select. If you use the 32-bit version of TWAIN,
EPSON TWAIN (32-bit) is selected instead.

Note:
You usually need to perform this step only the first time you use
the scanner with EPSON Scan! II.

3. Choose Aquire from the File menu to open EPSON TWAIN.

To scan the image placed on the document table of your
scanner, go to “Scanning an Image” on page 2-6.

For Macintosh

double-click
mopen

acq2, maca
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Starting EPSON TWAIN through your application
software

Application programs that support TWAIN allow you to scan
the image while the application is running. TWAIN is an
interface standard for scanning applications. To verify whether
your application is compatible with TWAIN, see your
application manual.

How you should open EPSON TWAIN and scan varies
depending on the application. Read the following to get a
general idea of how to access EPSON TWAIN.

1. Start your application.

2. Select your scanner in the application; for example, choose
Select TWAIN Source from the File menu, and then select
EPSON TWAIN.

Note:
You usually need to perform this step only the first time you use
the scanner with your application.

3. Choose Twain Acquire from the File menu to open EPSON
TWAIN.

To scan, see the next section.
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Scanning an Image 

When you open EPSON TWAIN, the following window
appears (Easy menu). This section shows you the easiest way to
scan using the Easy menu. For detailed information about the
settings on the Easy and Advanced menus, see Chapter 4.

Note for Macintosh users:
Most illustrations shown in this chapter are for Windows, so they
may vary from the actual dialog boxes that appear on your screen.
Since all of the settings and their functions are the same for both
Macintosh and Windows environments, please use the dialog boxes
here for reference.

Note:
If the following menu appears, click Easy to see the Easy menu. This
menu is the Advanced menu of EPSON TWAIN. For details, see
Chapter 4. 

1

2

3

4

twain-es

click

                   
twain-ad
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Follow these steps to scan an image:

1. Select the Document Source. 
You can select Flatbed, and Auto Document Feeder (the
optional document feeder) or Transparency Unit (the
optional transparency unit) depending on whether you
have installed options. For complete descriptions of
Document Source settings, see “Document Source” in
Chapter 4.

2. Select the Image Type. 
You can select the type of image you will scan from: 
Color Photo, 256 Colors, Black & White Photo, Color
Halftone, Color Drawing, Black & White Halftone, Line
Art, OCR, and Copy/Fax. For complete descriptions of
Image Type settings, see “Image Type” in Chapter 4.

3. Select the Destination.
You can select an output device for image reproduction
from: Screen, Impact Dot Printer, Thermal Printer, Inkjet
Printer, Laser Printer, Laser 600 dpi, FAX, OCR, General, 
and certain EPSON printers.

4. Click Scan. 
The scanned image is displayed on the screen.

The scanner scans your image according to the Image Type and
Destination settings you select. If you want more control over
the settings, use the Advanced menu. See Chapter 4 or online
help for complete descriptions of the settings. 

To exit from the EPSON TWAIN window, click Close. (Click
the left corner of the dialog box for Macintosh.) 
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Saving the Scanned Image 

❑ To save a scanned image in your application
 r Choose Save or Save As from the File menu. For 

details, see your application manual.

❑ To save a scanned image in EPSON Scan! II 
r Follow the steps below:

Note:
Parenthesized words in the following steps apply to Macintosh users.

1. Choose Save As from the File menu. The following dialog
box appears on the screen.

2. Select the directory (or folder) where the image will be saved.

3. Type a filename for your image in the File Name (Save Image
as) field.

4. Click OK (Save).

The image is saved in EPSON’s original file format. You can
open this saved file in EPSON Scan! II and export it in a
different format.

saveas
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Note:
EPSON Scan! II can only save and open images in EPSON’s original
file format; however, you can export the image to another application
in a different file format, as described in the next section.

Exporting a Scanned Image From EPSON Scan! II 

After scanning an image in EPSON Scan! II, you need to export
the image to use or edit it.

Note:
❑ The images saved in the EPSON Scan! II original file format

cannot be opened or imported in other application software.

❑ For information on the file formats your software can open, see
your software manual.

❑ EPSON Scan! II cannot open an exported image file. Always save
an image in the EPSON original format before exporting.

Follow these steps to export the scanned image from EPSON
Scan! II:

1. Choose Export from the File menu. The following dialog box
appears on the screen.

2. Select the directory (folder) where the image will be saved.

export
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3. Type a filename for your image in the File Name (Export
Image as) field.

4. Select the format in the File Format (Export File Format)
menu. Click the arrow to see a list of available formats.

Note:
❑ Formats available 

Windows: TIFF 5.0, EPS, DIB, PCX, TIFF 6.0 
(includes JPEG compression), and JPEG.

Macintosh: PICT, TIFF 5.0, EPS, TIFF 6.0 (includes 
JPEG compression), and JPEG.

❑ For more information on file formats and other features in
this dialog box, see “Export” on pages 3-3–6.

5. Click OK (Export).

The image is saved in the selected file format. For information
on importing the image into your application software, see
your software manual.

Getting Information Through Online Help 

For Windows Users:

If you use EPSON Scan! II, choose Help from the menu bar. 
The status bar (at the bottom of the window) also gives you
information on the features of EPSON Scan! II and EPSON
TWAIN when you move the mouse over a button or menu
item.

For Macintosh Users:

If you use EPSON Scan! II, choose Help from the Apple menu.
Balloon Help also gives you information on the features of
EPSON Scan! II and EPSON TWAIN.
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EPSON Scan! II is software that allows you to access EPSON
TWAIN to scan images. You can then save the scanned images
and export them into other application programs.

The following sections describe when to use the advanced
features in EPSON Scan! II.

Note:
Parenthesized words in the following apply to Macintosh users.

File Menu 

This section describes the commands located on the File menu
and the functions those commands perform. To access these
commands, open EPSON Scan! II and click File.

For detailed information about the settings in the EPSON
TWAIN window, see Chapter 4.

Select Source

Before using the scanner, choose Select Source and select
EPSON TWAIN from the Data Source name box. This procedure
only needs to be performed the first time you start scanning. 
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Acquire

To scan an image, choose Acquire. EPSON TWAIN opens and
one of the following dialog boxes appears.

Click Scan, and a scanned image of the document on the
document table will appear on your screen. Be aware that it
may appear behind the dialog box.

Save As

To save the scanned image in the EPSON Scan! II original file
format, choose Save As. Type a name for the file in the File
Name (Save image as) field, and then click OK (Save).

To save the scanned image in a file format that other
applications can open, see the section below.

Export

The files saved in the EPSON Scan! II original format (*.org)
cannot be opened in other application software. To use the
scanned image in your application software, you must save it
in an appropriate file format by exporting it. Follow the steps
below.

     twain-es, b
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Note:
EPSON Scan! II can only open files saved in the EPSON original file
format. Therefore, it is recommended that you first save your image in
the EPSON format in case there is a problem opening the image in
your application.

1. Choose Export. The following dialog box appears.

2. Select the directory (folder) where the file is to be saved. 

3. Type a name for the file in the File Name (Export image as) field.

4. Select the desired file format from the File Format (Export 
File Format) menu and then click OK (Export).

The following file formats are available:

TIFF 5.0: Standard Tagged Image File Format
version 5.0. Black-and-white images can be
exported with G3 compression.

EPS: Encapsulated PostScript file format

TIFF 6.0(JPEG): Tagged Image File Format version 6.0 with
JPEG compression

Note:
TIFF 6.0 (JPEG) can only be selected for
16-million color or 256-gray-level images.

export
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JPEG: Joint Photographic Experts Group format
for data compression

Note:
JPEG can only be selected for 16-million color
or 256-gray-level images.

DIB:
(Only for Windows)

Device-Independent Bitmap format for
Windows version 3.0 or later. 4-bit/pixel
images can be exported with RLE4
compression and 8-bit/pixel images can
be exported with RLE8 compression. RLE
stands for run-length encoding.

PCX:
(Only for Windows)

PC Paintbrush file format

Note:
PCX cannot be selected for 16-million color
images.

PICT:
(Only for Macintosh)

Standard QuickDraw picture format for 
Macintosh. Black & white images can be
exported with G3 compression and
16-million color or 256-gray-level images
can be exported with JPEG compression.

Note: 
If QuickTime has not been installed, the
Compression setting is dimmed and cannot be
selected.

Your software probably supports many of these formats. For
information on supported formats, see your software manual.

The DIB (256 color, 256 gray, 8 color, 16 gray) and TIFF 5.0
(Black & White) formats allow you to compress the file to be
exported. To compress the file, click the Compression
checkbox.
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If you select JPEG, TIFF 6.0 (JPEG), or PICT (JPEG
compression), you can adjust the image quality level from 1
(poorest) to 5 (highest) by moving the Quality slide bar at the
bottom of the dialog box.

Acquire and Export

To scan and save the image directly in a file format that your
application can open, choose Acquire and Export. Because the
scanned image does not appear on the screen, you can carry
out scanning operations more quickly using this method.

1. Choose Acquire and Export, EPSON TWAIN opens. 

2. Click Scan to open the Export dialog box.

Note:
If you have selected Auto Document Feeder as the
Document Source in EPSON TWAIN, a dialog box appears that
prompts you to select the number of pages to be scanned. Click
OK with All Pages selected to scan all pages loaded in the ADF.
Select Single Page for scanning one page at a time.

3. Select the directory (destination folder) where you want to
save the file.

4. Type a file name and set other options if desired. Click OK to
start scanning and save the image in the selected file format.

Note: 
If you have selected Auto Document Feeder as the
Document Source in EPSON TWAIN and type a file name with
more than 6 letters in the file name box, the last 2 letters may be
changed into a number that indicates the page order to be scanned.
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Close

Choose Close to close an image window.

Open

To open files that have been saved in the EPSON Scan! II
original format (*.org), choose Open.

Note:
EPSON Scan! II can only open files saved in the EPSON original file
format. Therefore, it is recommended that you first save your image in
the EPSON format in case there is a problem opening the image in
your application.

Exit

Choose EXIT (Quit) to close EPSON Scan! II.

Edit Menu 

This section describes the commands located on the Edit menu
and the functions those commands perform. To access these
commands, open EPSON Scan! II and click Edit.

Copy (and Select All) 

You can copy and paste the scanned image into other software.

1. Select the area of the scanned image to be copied by clicking
and dragging the mouse over that area, or click Select All
on the Edit menu to copy the entire image.

2. Click Copy on the Edit menu. The selected image will be
copied to the Clipboard.
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3. In your application, choose Paste (or a similar command). 

View Menu 

This section describes the commands located on the View
menu and the functions those commands perform. To access
these commands, open EPSON Scan! II and click View.

All Dots 1:1

Shows a scanned image with each pixel, or picture element,
corresponding to one display dot in the active window. The
higher the image resolution, the larger the display image.

Fit in Window

Modifies the size of the scanned image to match the current
size of the active window. The smaller the active window size,
the smaller the display image. This will center an image if the
window is larger than the image.

Window Menu 

Lists all the images that have been scanned and opened.

To see all the names of the images that are currently open, click
Window. Choosing a window name makes that window active
and brings it to the front of the screen.

L EPSON Scan! II Rev.C
A5 size Chapter 3
July-18-97 Pass 0, DR

3-8      Understanding EPSON Scan! II Features



Chapter 4
Understanding EPSON TWAIN Features

Proof Sign-off:
E. Ohtera _______
D. Grady _______

Scanning From the Easy Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-3

Scanning From the Advanced Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-4
Previewing images  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-5
Document Source  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-8
Image Type  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-8
Destination  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-13
Source and Target image sizes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-16
Image Controls  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-18
Tone Correction  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-21
Color Adjustment  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-23
Invert  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-25
Auto Exposure  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-25
Auto Locate  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-25
Configuration  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4-28

4

REPSON Scan! II Rev.C
A5 size Chapter 4
July-18-97 Pass 0, DR

Understanding EPSON TWAIN Features      4-1



When you start EPSON TWAIN through EPSON Scan! II or a
compatible application, one of the following windows appears
on the screen:

Note for Macintosh users:
Most illustrations shown in this chapter are for Windows, so they
may vary from the actual dialog boxes that appear on your screen.
Since all of the settings and their functions are the same for both
Macintosh and Windows environments, please use the dialog boxes
here for reference.

The following sections describe all of the features of EPSON
TWAIN.

Note:
Some settings may be dimmed and cannot be selected because of
incompatibility with your scanner or your choice of settings.

Easy menu Advanced menu

twain-es, base
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Scanning From the Easy Menu 

The Easy menu displays only the minimum required settings,
allowing you to scan easily and quickly. Just select the relevant
Document Source, Image Type, and Destination settings, then
click Scan. 

EPSON TWAIN automatically locates the target image on the
scanner, adjusts the exposure, and starts scanning. See page 4-8
through 4-16 for details about Document Source, Image Type,
and Destination settings.

Note:
❑ You cannot scan an image that exceeds available memory or disk

space. If you attempt to scan an image that is too large, an alert
appears on the screen.

❑ Before you begin scanning, you should calibrate your screen and
printer. For details, see Chapter 5, “Calibrating Your System.“

❑ After an image is scanned, be sure to save or export it. See pages
2-8 and 2-9 for details. 

If you want to make more settings on your own, click
Advanced to open the Advanced menu.

Easy menu

twain-es
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Scanning From the Advanced Menu 

The Advanced menu allows you to make detailed settings. You
can set parameters for a setting or select special functions
provided with EPSON TWAIN to make the highest quality
scanned images. 

Note: 
❑ Online help also provides you with information about settings.

See “Getting Information Through Online Help” in Chapter 2 for
information about using online help.

❑ You cannot scan an image that exceeds available memory or disk 
space. If you attempt to scan an image that is too large, an alert
appears on the screen.

❑ Before you begin scanning, you should calibrate your screen and
printer. For details, see Chapter 5, “Calibrating Your System.”

❑ After an image is scanned, be sure to save or export it. See pages
2-8 and 2-9 for details.

Advanced menu

base
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Previewing images

Before you scan and save an image, you can preview it in the
preview window located on the right of the Advanced menu.
Use the preview feature to check the image to be scanned. You
can also see the results of your settings in the preview window.

❑ To preview the entire image,
r click the preview button.

❑ To preview a part of the image that is already in the
preview window,

r Click and drag the mouse over the area you want 
to see in detail, and click the zoom preview button.

Note: 
❑ You cannot preview an image that exceeds available memory or

disk space. If you attempt to preview an image that is too large,
an alert appears on the screen.

❑ When the mouse pointer is placed within the marquee, (the frame
of the selected image area), the mouse pointer changes to a hand
icon. You can click and drag the marquee anywhere in the
preview window.

❑ When the mouse pointer is placed on the edge of the marquee, it
changes to an arrow allowing you to resize the marquee.

❑ To remove or delete a marquee, double-click the preview image.

zoom preview buttonpreview button preview
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Modifying the preview image

You can see the effects of the following settings in the preview
image.

❑ Pixel Depth, Halftone, and Dropout in the Image Type
dialog box

❑ Exposure, Gamma, Highlight, Shadow, Sharpness, and
Threshold in the Image Controls dialog box

❑ Tone Correction in the Tone Correction dialog box

❑ Gray Balance Intensity, Saturation, and Color Filter in the
Color Adjustment dialog box

❑ Invert

❑ Auto Exposure

Note:
Although the image in the preview window changes as you make
settings, the settings do not affect the actual image until you scan, or
rescan, the image.

preview
window

previeww
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Comparing the setting effects:

If you click a comparison button in the Image Controls or Color
Adjustment dialog box, three (or five) image samples appear in
the preview window. You can use these samples to compare
various setting effects with the original image, which appears
in the center.

Clicking one of the image samples causes that image to move
to the center, and a different set of image variations appears
based on the sample image you selected. You can repeat this
step until you obtain the desired image effect. Make sure the
image variation you wish to scan is the center sample, then
double-click that image to make it a full preview image in the
preview window.

For information on image settings, see the sections on Image
Controls and Color Adjustment. To change the number of
comparison samples, see “Configuration” on page 4-28.

comparison
buttons

im-comp

REPSON Scan! II Rev.C
A5 size Chapter 4
July-18-97 Pass 0, DR

Understanding EPSON TWAIN Features      4-7



Document Source 

Generally, leave the Document Source set to Flatbed. You can
select from Flatbed, and Auto Document Feeder (the
optional document feeder) or Transparency Unit (the optional
transparency unit) depending on whether you have installed
an option.

Note:
Uninstalled options are dimmed and cannot be selected. 

Flatbed:
Select this setting to use the document table of the scanner.

Auto Document Feeder:
Select this setting to use the optional auto document 
feeder.

Transparency Unit:
Select this setting to use the optional transparency 
unit. If your scanner can scan negative film, the
Transparency Unit setting is replaced with TPU for
Neg. Film and TPU for Pos. Film settings.

Image Type 

You always need to select the type of image to be scanned with
the Image Type list or button. 

doc-sou

Image Type button 

Image Type list
(predefined settings)

imagetyp
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Image Type list

The Image Type list provides the following predefined settings
for your convenience. EPSON recommends you use the
predefined settings first, and if the scanned image is
unsatisfactory, manually make the detailed settings described
in the next pages. Click the arrows on the right to view all of
the available settings. 

Color Photo:
16-million colors, best quality, and 1-pass scanning 
sequence

256 Colors:
256 colors and best quality

Black & White Photo:
256 grays and best quality

Color Halftone:
8 colors, hard halftone, and draft quality

Color Drawing:
8 colors and draft quality

Black & White Halftone:
Black-and-white, hard halftone, and draft quality

Line Art:
Black-and-white and draft quality

OCR:
Black-and-white, best quality, and Text Enhancement 
Technology

Copy/Fax:
Black-and-white, hard halftone, draft quality, and 
Auto Area Segmentation
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Image Type button

The Image Type button allows you to customize the 
Image Type settings. If you want to make the most detailed
settings available, use this feature.

Click the Image Type button, and the following dialog box
appears.

Image Type Name:
Names of predefined settings and custom settings you 
have saved appear in the Image Type Name list.

Pixel Depth:
Select scanning colors from: 
16 Million Colors, 256 Color, 8 Color, 256 Gray, 
16 Gray, and Black & White.

itype
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Halftone:
Select a halftone or dither setting to reproduce images 
using special dot patterns:
Mode A (Hard Tone), Mode B (Soft Tone), Mode C
(Net Screen), Dither A (4 x 4 Bayer), Dither B (4 x 4
Spiral), Dither C (4 x 4 Net Screen), Dither D (8 x 4
Net Screen), and None.

Note:
Halftone is available only when Pixel Depth is set to Black
& White or 8 Color.

Dropout:
Select a color to subtract that color from the scanned 
image. Available Dropout options are: 
None, Red, Green, and Blue.

Note:
Dropout is available only when Pixel Depth is set to Gray or
Black & White.

Quality & de-screening:
Select a scanning quality:
Draft & Fast or Best & de-screening.

Note:
When the Best & de-screening option is selected,
unwanted moiré patterns are automatically removed from
scanned images.

Scanning Sequence:
Select a scanning sequence between 1 pass (for line 
sequence) and 3 pass (for page sequence).

Note:
The 3 pass scanning sequence is available only when
16 Million Colors is selected as the Pixel Depth setting. 
If 3 pass is selected, Calibration, Color Filter, and Saturation
are ignored. See also the sections on Destination and Color
Adjustment.
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B/W Options:
The B/W Options setting is available only when 
Black & White is selected as the Pixel Depth setting.

Text Enhancement Technology
To raise the recognition accuracy during OCR (Optical
Character Recognition) scanning, check this radio
button. This function eliminates the document’s
background.

Auto Area Segmentation
To make grayscale images clearer and text recognition
more accurate, check this radio button. This function
separates text from graphics.

Note:
Auto Area Segmentation is available on the GT-5500,
GT-9500, and Expression 636 scanners.

To apply the settings you made, click OK. The Preview window
displays the effects of the current settings except for TET (Text
Enhance Technology) and AAS (Auto Area Segmentation)
settings.

To cancel the settings, click Cancel.

To save the settings you made as a group of custom settings,
type a new name in the Image Type Name box, then click Save.

To delete an Image Type setting, select the setting name to be
deleted in the Image Type Name menu, then click Delete.
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Destination 

Select the destination, or output device, where the scanned
image is to be printed or displayed with the Destination list or
button.

Note: 
The effects of the Destination settings cannot be viewed in the
preview window.

Destination list

The Destination list provides the following predefined settings
and any custom settings you have saved in the Destination
dialog box. Click the arrows on the right to view all the
available settings.

Destination name
Resolution for

CalibrationLine drawings and
halftone images 

Photos

Screen 72 dpi 72 dpi Screen
(display monitor)

Impact Dot Printer 360 dpi 120 dpi Impact Dot Printer

Thermal Printer 360 dpi 120 dpi Thermal Printer

Inkjet Printer 360 dpi 120 dpi Inkjet Printer

Laser Printer 300 dpi 100 dpi Laser Printer

Laser 600 dpi 600 dpi 200 dpi Laser Printer 600

FAX 200 dpi 200 dpi Inkjet Printer

OCR 300 dpi 300 dpi General

General 300 dpi 72 dpi General

EPSON Printer
model name

800 dpi 240 dpi EPSON Stylus*

*For Stylus COLOR users, select Stylus COLOR, and for Laser 600dpi users,
select Laser Printer 600.

Destination button Destination list 
(predefined settings)

destin01
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Destination button

The Destination button allows you to customize the
Destination settings. To make your own settings, such as
scanning resolution, click the Destination button. The
following dialog box appears.

Destination Name:
Names of the predefined and custom settings appear in 
the Destination menu.

Resolution:
Select a scanning resolution for “line drawings 
and halftone images” or “photos.”

Note: 
❑ When the Pixel Depth setting in the Image Type dialog box is set

to 8 Color or Black & White, the Drawing/Halftone setting
takes effect and the Photo setting becomes irrelevant. For other
Pixel Depth settings, the Photo setting takes effect and the
Drawing/Halftone setting becomes irrelevant.

destin02
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❑ To print your scanned document when Resolution is set to
Drawing/Halftone, select the same resolution setting from the
list as you select in the printer driver. To print your scanned
document when Resolution is set to Photo, select the resolution
setting that is approximately 1/3 of the resolution you select in
the printer driver; otherwise the Photo setting requires longer to
print, but does not improve the output quality.

❑ The Resolution setting is closely related to the Image Size and
Scale settings. If you change them arbitrarily, the resulting image
may not be what you expected.

❑ The availability of the resolution value depends on your scanner.

Calibration:
The Calibration menu lists the predefined settings and 
custom profiles that you have created with the EPSON
Printer Calibration utility. Select the predefined setting
or custom calibration profile that matches your output
device, such as printer or display monitor.

Note: 
❑ If  Windows ICM or Apple ColorSync has been selected in

the Configuration dialog box, the Calibration menu is dimmed
and cannot be selected.

❑ The Calibration setting takes effect only when the Scanning
Sequence is set to 1 pass in the Image Type dialog box. If 3 pass
is selected, the Calibration setting is ignored.

❑ To enable the Calibration setting when using a Macintosh, you
must set the Screen Calibration option in the Configuration
dialog box to EPSON Calibration.

If you have created your own calibration profiles for your
printer using the EPSON Printer Calibration utility, you can
select a relevant custom calibration profile from the Calibration
menu. For more information, see “Calibrating Your Printer” in
Chapter 5.
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To apply the settings you made, click OK. To cancel the
settings, click Cancel.

To save the settings you made, type a new name in the
Destination Name box, and then click Save.

To delete a Destination setting, select the target setting name to
be deleted in the Destination Name menu, then click Delete.

Source and Target image sizes

The Source fields indicate the size of the image that is
displayed or selected in the preview window. 

The Target fields indicate what size the image will be when it is
output.

Note:
❑ The image size values are ignored when you scan from the Easy

menu, meaning they are automatically optimized for your image.

❑ The image size setting is closely related to the Resolution. If you
change them arbitrarily, the resulting image may not be what you
expected.

scale1

 lock button

storage size

scale2
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Width and Height menu:
The width and height of an image are indicated in the 
selected unit of measure. You can type new values
directly in the indicator fields, or you can change the
image area in the preview window by creating a
marquee, or frame. You can create a marquee by
dragging the mouse over a certain area. See the notes
on page 4-5 for more information on marquees.

Units menu:
Select a unit of measurement. You can select from pixels, 
inches, and cm. As you change the unit, the vertical
and horizontal rulers in the preview window change.

Storage size indicator:
The storage size of an image is indicated in KB or MB. 
As you change the image area in the preview window,
the value changes. Use this indicator for your reference.

Lock button:
The current ratio of width-to-height of the target image
can be locked. If locked, the ratio of width-to-height of
the Source image changes according to the scale value,
or the scale value changes according to the ratio of
width-to-height of the Source image. This is especially
useful in cases where the size of an image does not fit
the paper size you want to print the image on, but you
want to keep the image’s original proportions. Enter
the size of the paper in the Width and Height fields of
the Target box and then click the lock button. The scale
value is automatically changed, maintaining the
current ratio of width-to-height to fit the paper.

Scale bar:
An image can be reduced or enlarged by moving the 
Scale slider. You can also click the left or right arrow to
change the image size in 1% increments.

The range of the possible reduction or enlargement 
varies depending on the current resolution setting.
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Scale indicator:
The percentage of enlargement or reduction is shown in 
the Scale indicator field. You can type a new value
directly in this field. When you move the Scale slider,
the value changes in this field.

Image Controls 

Click the Image Controls button on the Advanced
menu to view the following dialog box.

comparison
buttons

shadow
color

button

highlight
color

button

image-cn

L EPSON Scan! II Rev.C
A5 size Chapter 4
July-18-97 Pass 0, DR

4-18      Understanding EPSON TWAIN Features



Note:
❑ The Image Controls button is dimmed and not available when TET

(Text Enhancement Technology) is selected in the Image Type
dialog box. 

❑ The Image Controls settings are ignored when you scan from the
Easy menu, meaning they are automatically optimized for your
image.

❑ If Pixel Depth is set to Black & White and Halftone is set to
None in the Image Type dialog box, all the settings except
Threshold are dimmed and cannot be selected.

❑ You can see the effects of the Image Controls settings in the
preview window.

Exposure:
The Exposure setting lightens or darkens an image. You 
can select from -10 (darkest) to 20 (brightest) by moving
(click and drag) the slider.

Gamma:
Gamma is the contrast between the light tones and the 
dark tones in an image. You can select from 50 (lowest)
to 300 (highest) by moving the slider.

Highlight:
You can select from 60 (darkest) to 480 (lightest) by 
moving the slider.

If you click the highlight color button beneath the slider, 
the mouse pointer changes to an eyedropper icon.
Move the eyedropper over the preview image, and
click a bright area. The eyedropper “picks up” the color
from that area, and uses it as the highlight for the entire
image. This effect shows up immediately in the
preview image. Click Cancel to restore the original
image.
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Shadow:
You can select from 0 (lightest) to 50 (darkest) by moving 
the slider.

If you click the shadow color button beneath the slider, 
the mouse pointer changes to an eyedropper icon.
Move the eyedropper over the preview image, and
click a dark area. The eyedropper “picks up” the color
from that area, and uses it as the shadow for the entire
image. This effect shows up immediately in the
preview image. Click Cancel to restore the original
image.

Sharpness:
You can select from -2 (most defocused) to 2 (sharpest) 
by moving the slider.

Threshold:
Available only when Pixel Depth is set to Black & White 
and Halftone is set to None in the Image Type dialog
box. The scanner scans gray shades as either black or
white using this threshold setting.

You can select from 0 (lightest) to 255 (darkest) by 
moving the slider.

Comparison buttons:
If you click a comparison button (to the left of the 
settings), you can see several slightly varying image
samples in the preview window. For information on
using the comparison buttons and images, see page 4-7.

L EPSON Scan! II Rev.C
A5 size Chapter 4
July-18-97 Pass 0, DR

4-20      Understanding EPSON TWAIN Features



Tone Correction 

Click the Tone Correction button on the Advanced
menu to view the following dialog box.

Note:
❑ The Tone Correction settings are ignored when you scan from the

Easy menu.

❑ The Tone Correction button is dimmed and not available when
Pixel Depth is set to Black & White, Halftone is set to None,
and TET (Text Enhancement Technology) is selected in the Image
Type dialog box. 

❑ You can see the effects of the Tone Correction settings in the
preview window.

The tone value represents the contrast in the tonal relationship
between an original image and its reproduction on display
monitors or printers.

tone curve editor

tone correction list

tone
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Tone Curve editor:
Drag points on the tone curve to adjust the tone value. 
You can edit up to five points. The editor allows you to
customize the tone correction.

Output options:
If you click the check box for a specific point, such as 
1/4 Tone or Midtone, you can move that point and it
will remain in place; it will not be affected by the
movement of other points on the curve. If this box is
not checked, the point will be affected by the
movement of other points.

Channels options:
You can select the Master (RGB), red, green, or blue 
channel to modify all colors or just one.

Note: 
If Pixel Depth is set to Black & White, 16 Gray, or 256
Gray in the Image Type dialog box, you can select Master
only.

Tone correction list:
Select a tone correction setting from this list. The custom 
settings you have saved appear in this list.

Save button:
After you correct the tone, click Save and a dialog box 
appears. Type a name for your custom settings in the
Tone Correction Name field and click Save.

To delete a setting, select the name you want to delete 
in the dialog box and click Delete. To cancel the
operation, click Cancel.
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Color Adjustment 

Click the Color Adjustment button on the Advanced
menu to view the following dialog box.

Note: 
❑ The Color Adjustment settings are ignored when you scan from

the Easy menu.

❑ If Image Type has been set for grayscale or black-and-white
images, the Color Adjustment button is dimmed and these
settings cannot be selected.

❑ If the 3 pass scanning sequence is selected in the Image Type
dialog box, the Saturation and Color Filter settings are irrelevant.

❑ You can see the effects of the Color Adjustment settings in the
preview window.

color cast button

comparison
buttons

adjust
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Gray Balance Intensity:
Adjust the gray balance of a color combination that 
appears neutral gray by removing color casts from the
selected color.

If you click the color cast button beneath the slider, 
the mouse pointer changes to an eyedropper icon. Click
the color you want to modify. The eyedropper “picks
up” the color, then you can correct the cast level for that
color from 0 to 100 by moving the slider. The corrected
color appears in the box beside the color cast button.
This effect shows up immediately in the preview
image. Click Cancel to restore the original image.

Saturation:
Select the saturation level for colors from -100 (less color) 
to 100 (more color) by moving the slider. Saturation is
the property that defines a color as pale or rich.

The scanner scans the strength of colors using this 
saturation setting. 

Color Filter:
Select a color in the color wheel to increase the saturation 
of that color throughout the entire image.

Comparison buttons:
If you click a comparison button (to the left of the 
settings), you can see several slightly varying image
samples in the preview window. For information on
using the comparison buttons and images, see page 4-7.
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Invert 

Click the Invert button on the Advanced menu to
invert the colors in the preview image and final image.

Note: 
The Invert button is dimmed and not available when TET
(Text Enhancement Technology) is selected in the Image
Type dialog box, or TPU for Neg. film and TPU for Pos.
film is selected as the Document Source.

Auto Exposure 

Click the Auto Exposure button on the Advanced 
menu to automatically optimize the exposure for an 
image. The Highlight and Shadow settings in the 
Image Controls dialog box are automatically set.

Note:
❑ The Auto Exposure button is dimmed and not available when TET

is selected in the Image Type dialog box.

❑ The Auto Exposure feature is automatically activated when
scanning from the Easy menu.

Auto Locate

Click the Auto Locate button on the Advanced menu 
to cause the scanner to automatically locate and select 
the target image, then the image appears without 
white borders in the preview window.
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Note:
❑ The Auto Locate button is dimmed and not available when TET

(Text Enhancement Technology) is selected in the Image Type
dialog box.

❑ The Auto Locate feature is automatically activated when
scanning from the Easy menu.

If a document contains more than one image, select a target
image by roughly dragging the mouse pointer over the image
and clicking the Auto Locate button. The selected target
image automatically is located.

Auto Locate button

entire preview area located image

               autoloc1

Auto Locate button

located and
non-located images

target image and
other image

               autoloc2

L EPSON Scan! II Rev.C
A5 size Chapter 4
July-18-97 Pass 0, DR

4-26      Understanding EPSON TWAIN Features



Settings

Click the Settings button on the Advanced menu to view the
following dialog box. You can view all of the settings for the
current preview image in this dialog box. Also, you can apply
any custom settings you have saved from here.

To save the currently selected settings, type a new name in the
User defined settings field, then click Save.

To apply saved settings, select a setting name from the list,
then click OK. The preview image will reflect the settings you
saved.

To restore the prior settings, click Cancel.

To delete a setting, select the setting name in the list, then click
Delete.

To scan a single image using several variations of settings,
make and save each group of settings as described above. Then
hold down the Shift key while clicking the custom settings you
want to select in the User defined settings list. After selecting
all of the settings you want to use when scanning, click Batch
Scan. The scanner scans the image once for each group of
settings you have selected.

settings
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Configuration 

Click the Configuration button on the Advanced menu to
view the following dialog box. You can adjust the comparison
feature and screen calibration from here.

Save Preview Image and Settings:
Check this setting to automatically save the preview 
image and all the image settings when you exit EPSON
TWAIN (quit scanning). When you restart EPSON
TWAIN, the latest preview image and its settings
appear.

Number of comparison samples:
Select the number of comparison samples that appear in 
the preview window when you click a comparison
button in the Image Controls and Color Adjustment
dialog box. Your choices are 3 or 5 samples.

Windows

config

Macintosh

mconf
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Variation between samples:

Select the amount of variation for comparison samples 
that appear in the preview window when you click a
comparison button in the Image Controls and Color
Adjustment dialog box. Your choices are large,
medium, and small.

Windows ICM (for Windows)
Depending on the Windows version, this setting is not
available (dimmed).

Check this setting to reproduce the colors in your image using
Windows ICM color management system. 

Note:
If your output devices (printer and monitor) do not support Windows
ICM, leave this setting unchecked.

Screen Calibration (for Macintosh)
Select Apple ColorSync as the Screen Calibration setting in the
Configuration dialog box to use the ColorSync color
management system. 

Note:
If your output devices (printer and monitor) do not support
ColorSync, leave EPSON Calibration selected in the Configuration
dialog box.
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Calibrating Your System
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When you install EPSON Scan! II & EPSON TWAIN, two kinds
of color calibration utilities are automatically installed.

❑ EPSON Screen Calibration
Calibrate your monitor to ensure the tone and contrast on
your screen closely match those of the original image. This
utility automatically starts after installing EPSON Scan! II &
EPSON TWAIN. Be sure to calibrate your screen before
starting to use your scanner.

❑ EPSON Printer Calibration
Calibrate your printer to ensure the colors on your printout
closely match those of the original image.

For information regarding color and output device calibration,
see the Color Guide.

Calibrating Your Screen 

You only need to calibrate your screen when you first
install the scanner software, and anytime you switch 
to a different monitor. Click the EPSON Screen 
Calibration icon in the EPSON scanner window 
(EPSON Scan! II folder) to view the following dialog 
box.

scrncal
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Note:
View the screen from a slight distance. The gray stripes will not
perfectly blend together; the object is to make the different tones match
as much as possible.

1. Look at the screen from a distance and move the slider right
or left until the rows most closely match.

2. Click OK to finish calibrating your scanner and monitor.

The setting is automatically saved as the “Screen” profile in the
Calibration list in EPSON TWAIN’s Destination dialog box.
Screen profile contains calibration information for the preview
image as well as the scanned image.

Calibrating Your Printer 

You only need to calibrate your printer if the printout
from the predefined settings in the Destination list 
provide you with unsatisfactory print quality. Click 
the EPSON Printer Calibration icon in the EPSON 
Scanner window (EPSON Scan! II folder) to view the 
following dialog box.

1 Select the printer you want to calibrate from the drop-down
menu. (If you are running this utility from a Macintosh,
you cannot change the selected printer with this menu. Exit
the utility and select the printer using the Chooser.)

calib
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Note:
You need to generate a specific profile for each of your printer’s
settings. For example, the profiles for your printer’s coated paper
setting and for its plain paper setting may not be the same. To
change the printer settings, click Setup before printing the
calibration chart.

2. Click Print. Your printer prints the calibration chart.

Note:
If you have printed the calibration chart before with the same
printer, click Skip.

3. Place the calibration chart on your EPSON scanner as shown
in the illustration on the screen.

4. If you want to change the default file name (and profile
description for Windows), type your changes in the File
Name (and Description) fields.

5. Click Scan. The scanner scans the chart.

Note:
When calibration is finished, “Calibration profile completed”
appears on the screen.

6. Click OK to exit the calibration utility.

Note:
Align the guide mark on the upper
left corner of the chart with the
triangular origin mark on your
scanner’s document table.

prcar01
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The calibration utility compares the data from the original
scanned image with the printout of your printer, then saves the
“printer” profile with the file name you specified in step 4. It is
added to the Calibration list in EPSON TWAIN’s Destination
dialog box and ensures the accuracy and consistency of colors
between your scanner and your printer.

Using Windows ICM (For Windows 95 Users) 

If you use Windows 95 and your output devices (printer and
monitor) support the Windows ICM color management
system, you can use the Windows ICM calibration method. If
you checked Windows ICM in the Configuration dialog box,
the Calibration setting in the Destination list will be dimmed,
meaning it is not available.

Note:
If your output devices do not support Windows ICM, use the EPSON
Calibration utilities with Windows ICM unchecked.

Follow the steps below:

1. Run EPSON Scan! II and select Acquire or Acquire &
Export to start EPSON TWAIN.

2. Click Configuration. Check Windows ICM in the
Configuration dialog box.

3. Make any other settings you desire.

4. Click Scan. The scanner scans an image using the 
Windows ICM profile.
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Using ColorSync (For Macintosh Users) 

If your output devices (printer and monitor) support the 
Apple ColorSync color management system, you can use the
ColorSync calibration method. If you checked Apple
ColorSync in the Configuration dialog box, the Calibration
setting in the Destination list will be dimmed, meaning it is 
not available.

Note:
If your output devices do not support ColorSync, leave EPSON
Calibration checked in the Configuration dialog box.

Follow the basic steps below:

1. Run EPSON Scan! II and select Acquire or Acquire & Export
to start EPSON TWAIN.

2. Click Configuration. Check Apple ColorSync in the
Configuration dialog box, then select Perceptual,
Colorimetric, or Saturation from the drop-down list.

Note:
Select Perceptual for photographs, Colorimetric for spot
color, and Saturation for color charts or graphs.

3. Make any other settings you desire.

4. Click Scan. The scanner scans an image using the ColorSync
profile.

When the scanned image is printed or displayed with the
output device calibrated for the scanner, the image reproduced
is identical to the original.
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Problems and Solutions 

Most problems you encounter while operating your scanner
and software have simple solutions. This section divides the
problems into three categories:

Setup problems  ....................................... 6-3
Software operation problems  .............. 6-5
Scanning problems  .................................6-6

Read the appropriate section to find your problem; then follow
the recommended steps.

Note:
If some settings are dimmed in EPSON TWAIN, they cannot be
selected because of the capability of your scanner or your choice of
other settings.

If you cannot solve a problem after reading and following the
information in this chapter, contact your dealer or a qualified
customer support person for assistance.
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Setup Problems

EPSON Scan! II & EPSON TWAIN software cannot be installed.

Confirm that your computer type and operating system match
the requirements of your scanner. For system requirements, see
your scanner manual and page 1-2 in this guide.

Your scanner does not appear in the Port list of the EPSON
TWAIN Setup dialog box when you connect the SCSI model to
your PC.

Turn off the scanner and computer, then make sure the
interface cable is firmly connected between the scanner and
computer.

Change the SCSI ID number to an unused number. See your
scanner manual.

Check the connection sequence and reset the termination
function if necessary. See your scanner manual. 

No image appears after you click Test in the EPSON TWAIN
Setup dialog box when using a PC.

Turn on the scanner and place a document on the document
table of the scanner.

Turn off the scanner and your computer, then make sure the
interface cable is firmly connected between the scanner and
computer.

Make sure the interface cable meets the requirements for the
interface connection. See the interface board manual.

Make sure that the interface board is installed correctly and
securely.
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For parallel interface users: 

Make sure that the interface board is compatible with your
scanner.

Change the I/O port address to an unused value. See your
computer and parallel interface manual. Write down the
I/O port address, and specify it when making the port
setting in the EPSON TWAIN Setup dialog box.

Note: 
Windows NT does not support bidirectional parallel interfaces.

For SCSI interface users:

Turn off the scanner and your computer. Turn on the scanner;
then turn on your computer. See “Power-on Sequence” in
your EPSON scanner manual.

Make sure the SCSI driver is properly installed.

Change the SCSI ID number to an unused number. See your
scanner manual.

Check the connection sequence and set the termination
properly. See your scanner manual. 
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Software Operation Problems

EPSON TWAIN does not start.

Make sure the scanner is turned on. 

Note:
If you use a SCSI interface, be sure to turn on the scanner before you
turn on your computer.

Turn off the scanner and your computer. Make sure the
interface cable is securely connected between the scanner and
computer. Turn on the scanner; then turn on your computer.
See “Power-on Sequence” in your EPSON scanner manual.

Make sure the interface cable meets the requirements for the
interface connection. See the interface board manual.

Make sure that EPSON TWAIN is selected properly in your
application software. See “Starting EPSON TWAIN through
your application software”on page 2-5.

Make sure the interface board is properly installed. See your
interface board manual.

Optional equipment (Auto Document Feeder or Transparency
Unit) cannot be selected.

Make sure that your optional equipment is correctly installed.
For instructions on installing the Auto Document Feeder and
Transparency Unit, see your scanner manual.
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Scanning Problems

Image is dark, and there is little or no detail in the image.

Calibrate the screen. See “Calibrating Your Screen” on page 5-2.

Make sure that Screen is selected as the Destination setting in
EPSON TWAIN to optimize the screen display.

Note: 
If you have selected a printer for your output device, the colors
displayed on your screen may not match the actual photo colors;
however colors will reproduce correctly when the image is printed. Set
the Destination setting to match the target device. 

Images cannot be scanned at all or only a few dots appear in the
scanned image.

Make sure that you have placed a document on the document
table of the scanner.

When you have selected OCR as the Image Type setting, try
changing Threshold in the Image Controls dialog box. See
"Image Control" in Chapter 4.
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Moiré (cross hatch) patterns appear in the scanned image.

This problem occurs when images that include halftone screens
are scanned. To minimize moiré patterns, try any of the
following solutions:

Place a transparent sheet between the document and the
document table to slightly defocus the image.

Move or angle the document slightly.

Select Best & de-screening in the Image Type settings.

Change Sharpness to the defocus level.

Change the Target image size slightly.

The image appears too large on the screen.

Select Screen as the Destination setting to match the resolution
of your screen and scanner.

Note: 
Computer-screen resolution is generally between 70 and 90 dpi, while
the resolution of a scanned image may be much higher. Some
applications will enlarge the image so that all of its pixels appear on
the screen with higher resolutions, producing a greater degree of
enlargement.

If you select a printer as the Destination setting, the printed
image will appear in the correct size even if some applications
enlarge the image on the screen.
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Colors in the image are strange or different from the original.

Make sure that the Image Type and Destination settings in
EPSON TWAIN are correctly made.

Character recognition accuracy is very poor when OCR scanning.

Select OCR as the Image Type and Destination settings in
EPSON TWAIN.

Try changing the Threshold value in the Image Controls dialog
box. See “Image Controls” in Chapter 4.

If your document paper is not white or includes background
noise, select Text Enhancement Technology as the Image
Type setting.

The image does not print out correctly.

Try calibrating your printer. See Chapter 5 for information
about printer calibration.

Printed colors will not exactly match the colors on your
monitor, since printers and monitors use different color
systems: monitors use RGB (red, green, and blue), while
printers typically use CMYK (cyan, magenta, yellow, and
black).
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Glossary 

additive primary colors

Primary colors which produce white when mixed in a certain
proportion. These are red, green, and blue—the colors of the
scanner lamps and color monitor displays.

bi-level data

Image data that is composed of 1 bit/pixel. A pixel is
represented by a single bit of digital data that can express only
1 (light) or 0 (dark). See bit/pixel.

bit

Short for binary digit. The smallest unit of data in computer
processing. A bit can represent two values, on and off, or 1 
and 0.

bit/pixel

The unit that indicates the number of bits allocated for a pixel.
The larger the value, the more detail a pixel can represent.

byte

A unit of information consisting of eight bits. A byte can
represent a control code or character.

carriage

A component of the scanner that contains the optical sensor
and light source for scanning. 
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color correction

A method of adjusting the color image data for a particular
type of device so that the reproduction results come close to the
original colors.

color separation

A process to convert full-color images into a limited number of
primary colors. The additive primary colors (red, green, and
blue) are used by the scanner and the subtractive primary
colors (cyan, magenta, and yellow) plus black are used for
printing press separations.

default

A set of values used when no other selections have been made.

dithering

A process in which software or an output device simulates
continuous tones with groups of dots.

document

The physical item, such as a sheet of paper or a book, that you
place on the document table for the scanner to read.

dpi

Short for dots per inch. A unit of measurement for resolution.
The higher the value, the higher the resolution.

dropout color

A color you set the scanner not to recognize.
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 ESC/I

Abbreviation for EPSON Standard Code for Image scanners, a
system of commands that is used to control image scanners.

ESC/P

Abbreviation for EPSON Standard Code for Printers, a system
of commands that is used to control printers.

Exposure

A scanner function that lightens or darkens the scanned image
data. 

halftoning 

Methods of using dot patterns to represent an image.

home position

The position at the back of the scanner where its carriage rests
before a scanning operation.

imagesetter

A device that uses computer files to produce high-resolution
text and graphics output on film or paper. These are usually
found in service bureaus and printing companies.

impact dot printer

A printer that transfers ink onto the paper by striking an ink
ribbon with a number of small pins.

ink jet printer

A printer that sprays ink onto paper through a number of small
nozzles. 
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interface

A piece of hardware, a method, or a standard used for
connection between or among computer devices and
peripherals.

line sequence

A type of color scanning that separates primary colors line by
line. The carriage makes only one pass.

marquee

A moveable and adjustable frame that marks the area of an
image that will be previewed or scanned.

monochrome

Black and white images, or images represented only by the
intensity of luminosity.

page sequence

The type of color scanning in which the entire image is scanned
once for each separation color.

pixel

Short for picture element. Every image is composed of a
number of pixels. Pixels are also counted in units of dots.

plain bi-level

Bi-level image data without the halftoning process. 

port

An interface channel through which data is transmitted
between devices.
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primary colors

Basic colors. See additive primary colors and subtractive primary
colors.

resolution

Indication of how finely an image is resolved into pixels.
Measured in dots per inch (dpi), pixels per inch (ppi), or
samples per inch (spi).

scan

An operation performed by the sensor and the carriage. The
sensor “reads” the colors in an image, and sends the color
information to the computer or an output device as digital data.

scanning area

The physical size of the area that will be scanned by the
scanner. 

subtractive primary colors

Primary colors that produce black when mixed in certain
proportions. These are cyan, magenta, and yellow. In printing,
black is often added to give more definition because the mixing
of color inks cannot produce pure black.

threshold

A value that is referenced to determine how data is
represented; for example the data is represented as 1 (or on) if
the value of the data is larger than the threshold value, and the
data is represented as 0 (or off) if the value of the data is
smaller than the threshold value. Scanners use a number of
thresholds to convert an image into digital data.
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tone correction

Methods of adjusting the tone curve that make sure the
reproduced image is as close to the original as possible. Output
devices require different methods.

tone curve

The graph that shows the contrast between the input (original
image) and output (image data) in image processing.
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1 pass, 4-9, 4-11
3 pass, 4-11
4 × 4 Net Screen, 4-11
8 color, 4-9–11
8 × 4 Net Screen, 4-11
16 Gray, 4-10
16 Million Colors, 4-10–11
256 Colors, 2-7, 4-9–10
256 Gray, 4-9–10

A
Acquire, 2-4–5, 3-3
Acquire and Export, 3-6
Advanced menu, 4-2, 4-4
All Dots (1:1), 3-8
Auto 

document feeder, 4-8
Exposure, 4-25
Locate, 4-25–26
Area Segmentation (AAS),

4-12

B
Bayer, 4-11
Best & de-screening, 4-11
Black & White, 4-9–12, 4-14, 4-19
Black & White Photo, 2-7, 4-9–10
B/W Options, 4-12

C
Calibration, 1-11–12, 4-11, 4-15,

5-2–5
Centimeters, 4-17
Channels buttons, 4-22
Close, 2-8, 3-3, 3-7
Color 

Adjustment, 4-7, 4-23–24
Cast button, 4-23–24
Drawing, 4-9
Filter, 4-6, 4-11, 4-24
Halftone, 2-7, 4-9
Photo, 2-7, 4-9

ColorSync 2.0, 1-3, 4-15, 5-6
Comparison 

button, 4-7, 4-18, 4-20, 4-23–24
samples, 4-28–29

Compression, 3-4–5
Configuration, 4-28
Copy, 3-7

D
Destination, 2-7, 4-13–16
DIB, 2-10, 3-5
Disk space, 4-3–4
Dither, 4-11
Document 

Feeder, 4-8
Source menu, 2-7, 4-8

Draft & Fast, 4-11
Dropout, 4-6, 4-11
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E
Easy menu, 2-6, 4-2–3 
Edit menu, 3-7
EPS, 2-10, 3-4
EPSON 

calibration, 1
Printer Calibration utility,

5-3–5
Scan! II, 1, 1-4, 1-6, 2-2–3,

2-8–10, Chapter 3
icon, 2-3–4
starting, 2-3
Screen Calibration utility,

5-2–3
TWAIN, 1, 1-4, 2-2–10, 3-6,

Chapter 4
Exit, 3-7
Export, 2-9–10, 3-3–6
Exposure, 4-6, 19

F
File format, 2-8–10, 3-4–5
File menu, 2-4, 2-8–10, 3-2–7
Filename, 2-8, 2-10, 3-2
File Name field, 2-8, 2-10, 3-3–4
Fit in Window, 3-8
Flatbed, 2-7, 4-8

G
Gamma, 4-6, 4-19
General, 2-7, 4-13
Gray Balance Intensity, 4-6, 4-23

H
Halftone, 4-6, 4-11
Hard Tone, 4-11
Hardware requirements, 1-2–3
Height setting, 4-16
Help, getting, 2-10
Highlight, 4-6, 4-19
Highlight Color button, 4-18–19

I
Image,

Controls, 4-18–20
exporting, 2-9–10, 3-3–6
saving, 2-8, 3-3
scanning, 2-6–7, 4-3–4
Size, 4-16–18
Type, 2-6–7, 4-8–12
button, 4-10
Name menu, 4-10

Impact Dot Printers, 2-7, 4-13
Inches, 4-17
Inkjet Printer, 2-7, 4-13
Installation software, 1-4, 1-9–10

before, 1-2
Interface, 1-2–3
Invert, 4-25

L EPSON Scan! II Rev.C
A5 size Index
July-18-97 Pass 0, DR

IN-2      Index



J
JPEG, 2-10, 3-4–6

L
Laser Printer, 2-7, 4-13
Line Art, 2-7, 4-9–10
Lock button, 4-16–17

M
Macintosh, 1-10
Memory, 4-3–4
Mode, 4-11

N
Net Screen, 4-11
Number of comparison samples,

4-28

O
OCR, 2-7, 4-9–10
Open, 3-7
Original file format, 2-8, 3-3
Output options, 4-21–22

P
PCX, 2-10, 3-5
PICT, 2-10, 3-5–6
Pixel Depth, 4-6, 4-10
Pixels, 4-17
Preview

button, 4-5
window, 4-6

Printer calibration, 5-3–5

Q
Quality & de-screening, 4-11
Quality slider, 3-6

R
Resolution, 4-13–16

S
Samples, 4-28–29
Saturation, 4-6, 4-11, 4-24
Save, 2-8
Save As, 2-8, 3-3
Save button, 3-3, 4-12, 4-22
Scale, 4-16–17

bar, 4-17
indicator, 4-18

Scan button, 2-6–7, 3-3, 3-6, 4-3
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Scanner, 1-2
Scanning sequence, 4-11
Screen

calibration, 1-11–12, 4-29,
5-2–3

setting, 2-7, 4-13
Select All, 3-7
Shadow

Color button, 4-18
settting, 4-6, 4-20

Sharpness, 4-6, 4-20
Soft Tone, 4-11
Software requirements, 1-2–3
Source, 4-16
Spiral, 4-11
Storage Size indicator, 4-16–17
System, 1-2–3

T
Target, 4-16
TEST button, 1-8
Text Enhancement Technology

(TET), 4-12
Thermal Printer, 2-7, 4-13
Threshold, 4-6, 4-20
TIFF 

5.0, 2-10, 3-4–6
6.0(JPEG), 2-10, 3-4–6

Tone 
Correction, 4-6, 4-21–22
Correction list, 4-22
Curve editor, 4-21–22

Transparency unit, 2-7, 4-8
Troubleshooting, Chapter 6
TWAIN Select Source, 2-4

U
Unit of measure, 4-6
Units menu, 4-17

V
Variation between samples, 4-29
View menu, 3-8

W
Width setting, 4-16–17
Window menu, 3-8
Windows 

3.1x, 1-9
95, 1-4
ICM, 4-29, 5-5
NT 3.5x, 1-9
NT 4.0, 1-4

Z
Zoom Preview button, 4-5
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EPSON OVERSEAS MARKETING LOCATIONS

EPSON AMERICA, INC.
20770 Madrona Ave.

P.O. Box 2842

Torrance, CA 90509-2842

Phone:  (800) 922-8911

Fax:  (310) 782-5220

EPSON UK LTD.
Campus 100, Maylands Avenue,

Hemel Hempstead, Herts,

HP2 7TJ, U.K.

Phone:  (+44) 01442 61144

Fax:  (+44) 01442 227227

EPSON DEUTSCHLAND GmbH
Zülpicher Straße 6,

40549 Düsseldorf Germany

Phone:  (0211) 56030

Telex:  8584786

EPSON FRANCE S.A.
68 bis, rue Marjolin

92300, Levallois-Perret, France

Phone:  33.1.40.87.37.37

Telex:  610657

EPSON AUSTRALIA PTY. LTD.
70 GIBBES STREET, CHATSWOOD 2067 NSW.

Phone:  2-9903-9000

Fax:  2-9903-9177

EPSON SINGAPORE PTE. LTD.
No. 1 Temasek Avenue #36-00

Millenia Tower, Singapore 039192

Phone:  (065) 33 77 911

Fax:  (065) 33 41 185

EPSON HONG KONG LTD.
Rooms 4706-10, 47/F,

China Resources Bldg.,

26 Harbour Road, Wanchai, Hong Kong

Phone:  2585-4300

Fax:  2827-7083

EPSON TAIWAN TECHNOLOGY &

TRADING LTD.
10F, No. 287 Nanking E. Road, Sec. 3,

Taipei, Taiwan, R.O.C.

Phone:  (02) 717-7360

Fax:  (02) 712-9164

EPSON ITALIA S.p.A.
V.le F.lli Casiraghi 427

20099 Sesto S.Giovanni

MI, Italy

Phone:  2-262331

Fax:  2-2440750

EPSON IBERICA S.A.
Av. de Roma, 18-26

08290 Cerdanyola del Valles

Barcelona, Spain

Phone:  582. 15.00

Fax:  582. 15.55

SEIKO EPSON CORPORATION

(Hirooka Office)
80 Harashinden, Hirooka

Shiojiri-shi, Nagano-ken

399-07 Japan

EPSON PORTUGAL, S.A.
R. do Progresso, 471, 1º Perafita

4460 Matosinhos, Portugal

Phone:  (02)  996 14 02

Fax:  (02) 996 14 11
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